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About this Manual

This Manual is applicable to Guarding Expert Client Software.

The Manual includes instructions for using and managing the product. Pictures, charts, images and all
other information hereinafter are for description and explanation only. The information contained in
the Manual is subject to change, without notice, due to firmware updates or other reasons. Please
find the latest version in the company website.

Please use this user manual under the guidance of professionals.

Legal Disclaimer

REGARDING TO THE PRODUCT WITH INTERNET ACCESS, THE USE OF PRODUCT SHALL BE WHOLLY AT
YOUR OWN RISKS. OUR COMPANY SHALL NOT TAKE ANY RESPONSIBILITES FOR ABNORMAL
OPERATION, PRIVACY LEAKAGE OR OTHER DAMAGES RESULTING FROM CYBER ATTACK, HACKER
ATTACK, VIRUS INSPECTION, OR OTHER INTERNET SECURITY RISKS; HOWEVER, OUR COMPANY WILL
PROVIDE TIMELY TECHNICAL SUPPORT IF REQUIRED.

SURVEILLANCE LAWS VARY BY JURISDICTION. PLEASE CHECK ALL RELEVANT LAWS IN YOUR
JURISDICTION BEFORE USING THIS PRODUCT IN ORDER TO ENSURE THAT YOUR USE CONFORMS THE
APPLICABLE LAW. OUR COMPANY SHALL NOT BE LIABLE IN THE EVENT THAT THIS PRODUCT IS USED
WITH ILLEGITIMATE PURPOSES.

IN THE EVENT OF ANY CONFLICTS BETWEEN THIS MANUAL AND THE APPLICABLE LAW, THE LATER

PREVAILS.
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Chapter 1 Overview

1.1 Description

Guarding Expert is a versatile video management software for the DVRs, NVRs, IP cameras, encoders,
decoders, VCA device, security control panel, video intercom device, etc. It provides multiple
functionalities, including real-time live view, video recording, remote search and playback, file backup,
alarm receiving, etc., for the connected devices to meet the needs of monitoring task. With the
flexible distributed structure and easy-to-use operations, the client software is widely applied to the
surveillance projects of medium or small scale.

This user manual describes the function, configuration and operation steps of Guarding Expert
software. To ensure the properness of usage and stability of the software, please refer to the contents

below and read the manual carefully before installation and operation.

1.2 Running Environment

Operating System: Microsoft Windows 7/Windows 8.1/Windows 10 (32-bit or 64-bit),
Microsoft Windows XP SP3 (32-bit),
Microsoft Windows 2008 R2/Windows Server 2012 (64-bit).
CPU: Intel Pentium IV 3.0 GHz or above
Memory: 2G or above
Video Card: RADEON X700 Series or above
GPU: 256 MB or above
Notes:
®  For high stability and good performance, these above system requirements must be met.
® The software does not support 64-bit operating system; the above mentioned 64-bit operating
system refers to the system which supports 32-bit applications as well.
® Hardware decoding function is only supported by operating systems the version of which is after
Windows XP.

1.3 Function Modules

Control Panel of Guarding Expert:
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File System View Tool Help

B ControlPanel |

J@l Guarding Expert admin @ & ¥8 1957118 - b x|

Operation and Control

Maintenance and Management

Device Management
ing and deleting the
and groups.

ting users and assigning
nissions

Remote P
ﬁ Add odifying, deleting, and basic
E operalions of E-map.

ol

Alarm Event
Displaying the Alarm and Event
L_| Information

ord files and

*

Event Management
Configuring the alarm, exceptio

rs and the linkage aclions fo
s

24 Storage Schedule
t L) Configuring the storage schedule and

== related parameters.

System Configuration
Configuring general parameters:

Open Image File Search and view the captured pictures stored on local PC.
. Open Video File Search and view the video files recorded on local PC.
File Open Log File View the backup log files.
Exit Exit the Guarding Expert client software.
Lock Lock screen operations. Log in the client again to unlock.
Switch User Switch the login user.
Import System Config File Import client configuration file from your computer.
System Export System Config File Export client configuration file to your computer.
Import the access control data (including access control
Import from Access Control | devices, access control points, alarm inputs, and cameras
Client of access control terminal) of the Guarding Expert Access
Control client to the Guarding Expert client software.
1024*768 Display the window at size of 1024*768 pixels.
1280*%1024 Display the window at size of 1280*1024 pixels.
1440*%900 Display the window at size of 1440*900 pixels.
1680%1050 Display the window at size of 1680*1050 pixels.
Maximize Display the window in maximum mode.
— Control Panel Enter Control Panel interface.
Main View Open Main View page.
Remote Playback Open Remote Playback page.
Video Wall Open Video Wall page.
E-map Open E-map page.
Security Control Panel Open Security Control Panel page.
Video Intercom Open Video Intercom page.
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Auxiliary Screen Preview Open Auxiliary Screen Preview window.
Device Management Open the Device Management page.
Event Management Open the Event Management page.
Storage Schedule Open the Storage Schedule page.
Account Management Open the Account Management page.
Log Search Open the Log Search page.
System Configuration Open the System Configuration page.
Tool Broadcast Select camera to start broadcasting.
Device Arming Control Set the arming status of devices.
Alarm Output Control Turn on/off the alarm output.
Batch Wiper Control Batch starting or stopping the wipers of the devices.
Batch Time Sync Batch time synchronization of the devices.
Player Open the player to play the video files.
Message Queue Display the information of Email message to be sent.
Open Wizard Open the guide for the client configuration.
Open Video Wall Wizard Open the guide for the video wall configuration.
Click to open the User Manual; you can also open the User
Help User Manual (F1) Manual by pressing F1 on your keyboard.
About View the basic information of the client software.
Language Select the language for the client software and reboot the
software to activate the settings.

The Guarding Expert client software is composed of the following function modules:

The Main View module provides live view of network cameras and video encoders, and

supports some basic operations, such as picture capturing, recording, PTZ control, etc.

po2202208

= The Remote Playback module provides the search, playback, export of video files.
= The Alarm Event module displays the alarm and event received by the client software.
mmm The Video Wall module provides the management of decoding device and video wall and
- -
-

the function of displaying the decoded video on video wall.

The E-map module provides the displaying and management of E-maps, alarm inputs, hot
regions and hot spots.

The Security Control Panel module provides operations such as arming, disarming,
bypass, group bypass, and so on for both the partitions and zones.

The Video Intercom module provides video intercom with Guarding Expert via indoor

e ™ s

station, group management, card management and notice management.
The Statistics module provides functions of heat map, people counting statistics, counting

statistics, road traffic, face retrieval, license plate retrieval, behavior analysis, and face

L
—

capture statistics.

The Device Management module provides the adding, modifying and deleting of different

devices and the devices can be imported into groups for management.
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o 8 The Event Management module provides the settings of arming schedule, alarm linkage
actions and other parameters for different events.
i:_‘ The Storage Schedule module provides the schedule settings for recording and pictures.
= The Account Management module provides the adding, modifying and deleting of user
@™  accounts and different permissions can be assigned for different users.
‘I The Log Search module provides the query of system log files and the log files can be
18|

filtered by different types.

The System Configuration module provides the configuration of general parameters, file

5
8

~=%§5  saving paths, alarm sounds and other system settings.

The function modules are easily accessed by clicking the navigation buttons on the control panel or by

selecting the function module from the View or Tool menu.

You can check the information, including current user, network usage, CPU usage, memory usage and

time, in the upper-right corner of the main page.

1.4 Updates Instruction

Multiple newly-designed functions are offered in the latest Guarding Expert client software. You can

get a brief view of the updates instruction from the following contents.

High DPI Compatible

Compatible with High DPI Screen.

POS Playback

Support searching the video files which contain POS information.

Communication with Access Control Client

Support communication with the Access Control Client, and it provides further functions after
importing the access control devices, including access control event configuration, displaying
access control point on E-map, alarm/event linkage, and so on.

Display Zone and Access Control Point on E-map

Support displaying the zone of security control panel and access control point of access control
device on the E-map.

New Structure of System Configuration

Provide new structure in System Configuration module.

Set Icon on Live View and Playback Toolbar

Set the icon display on the toolbar of live view and playback window.

Frame Extracting for High-speed Playback

When play back the video in high-speed (8x speed and above), you can disable this function to
make the image of playback more fluent to view the details.

Prioritize to View Latest Alarm

Set to view the latest alarm in priority when viewing the alarm information in the pop-up alarm
window.

Customize Alarm Sound

Support custom alarm sound as desired.
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Search Video File in 31 Days
Support searching video files during up to 30 days.
Provide Player

Provide Player in the installation directory to view the downloaded video file.

10
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Chapter 2 User Registration and Login

For the first time to use Guarding Expert client software, you need to register a super user for login.

Steps:

1.

Input the super user name and password. The software will judge password strength
automatically, and we highly recommend you to use a strong password to ensure your data
security.

Confirm the password.

Optionally, check the checkbox Enable Auto-login to log into the software automatically.

Click Register. Then, you can log into the software as the super user.

Register Administator x

Please create a super user before proceeding.
Super User:

Password:

Confirm Password:

Enable Auto-login

@ A user name cannot contain any of the following characters: /\ : * ? “< > [. And the length of

the password cannot be less than 6 characters.

@ For your privacy, we strongly recommend changing the password to something of your own

choosing (using a minimum of 8 characters, including upper case letters, lower case letters,

numbers, and special characters) in order to increase the security of your product.

@ Proper configuration of all passwords and other security settings is the responsibility of the

installer and/or end-user.

When opening Guarding Expert after registration, you can log into the client software with the

registered user name and password.

Steps:

1.

Input the user name and password you registered.

Note: If you forget your password, please click Forgot Password and remember the encrypted
string in the pop-up window. Contact your dealer and send the encrypted string to him to reset
your password.

Optionally, check the checkbox Enable Auto-login to log into the software automatically.

Click Login.
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2 [admin|
&

Enable Auto-login

After running the client software, a wizard will pop up to guide you to add the device and do some
basic settings. For detailed configuration about the wizard, please refer to the Quick Start Guide of

Guarding Expert.
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Chapter 3 Device Management

3.1 Adding the Device

Purpose:

After running the Guarding Expert, devices including network cameras, video encoders, DVRs, NVRs,
decoder, security control panel, video intercom device, etc., should be added to the client for the
remote configuration and management, such as live view, playback, alarm settings, etc.

Perform the following steps to enter the Device Adding interface.

Steps:

1. Click the e icon on the control panel,
or click Tools->Device Management to open the Device Management page.
Click the Server tab.
3. Click Encoding Device/Door Station to enter Encoding Device/Door Station Adding interface.

Note: Here we take the adding of encoding device as an example.

&= Sever & Group

e Device for Management (3)
_ Add Device [7] Modif Delete Remote OR Code Activate & Online U Refresh All Filler

& Decoding Device Nickname = |IP Device Serial No. Security Net Status HDD Statu

B cascaaing Sever 10.16.1.250 10.16.1.250 20141119CCWRA4903406798 Strong (a)

Video Wall Controller Heat Map 10333162 2 fa)

G Third-party Enceding Device | ntersection 1009105140  DS-9516N-5T1620130301BBRR407T129305WCVU  Weak (a]

& Securlty Control Panel

& Indoor Station/Master Station

Ell Storage Server

@ Stream Media Server

Add New Device Type
Online Device (3) Refresh Every 805 ¥
Add o Client Add All Modify Netinfo Reset Password Activate Filter
P “ | Device Type Firmware Version Security Server Port | Start Time Adle

Encading devicelOutdoor Device 10.16.1.250 V5.3.12build 151103 Active 8000 2015-12-01 16:54:37 Ye
DVRIDVS/NVRAPCPD/VMS-4200
e 10.16.1.20 DS-7104HQHIF 1N V3.4.0build 151113 Active 2000 2015-11-30 17:02:54 N ‘
server/Door Station/Outer Door =
Station/Daor Station (V Series)

You can add the device in the following ways:

By detecting the online devices, see Section 3.1.2 Adding Online Devices.

By specifying the device IP address or domain name, see Section 3.1.3 Adding Devices Manually.
By specifying an IP segment, see Section 3.1.4 Adding Devices by IP Segment.

By IP Server, see Section 3.1.5 Adding Devices by IP Server.

By HiDDNS, see Section 3.1.6 Adding Devices by HiDDNS.

Adding Devices in batch, see Section 3.1.7 Batch Adding Devices.

3.1.1 Creating the Password

Purpose:
13
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For some devices, you are required to create the password to activate them before they can be added

to the software and work properly.

Note: This function should be supported by the device.

Steps:

Enter the Device Management page.
On the Device for Management or Online Device area, check the device status (shown on

Security column) and select an inactive device.

Online Device (4) + % Refresh Every 60s

o= Addto Client <= AddAll Modify Netinfo Reset Password Activate Filter
IP | Device Type Firmware Version Security Server Port | Start Time At
10.16.1.102 DS-G701HFHN V1.0.0build 150730 Active 5000 2015-08-17 14:57:51 N("7‘|
192.168.1.64 DS-2ZMMN3006(YF) V5.3.0build 150323 5000 2015-08-17 16:01:02 Me—
10.16.1.93 V5.3.10build 150729 Active 5000 2015-08-17 09:02:35 Mt -
“ .

Click the Activate button to pop up the Activation interface.

Create a password in the password field, and confirm the password.

STRONG PASSWORD RECOMMENDED- We highly recommend you create a strong password of

your own choosing (using a minimum of 8 characters, including upper case letters, lower case

letters, numbers, and special characters) in order to increase the security of your product. And we
recommend you reset your password regularly, especially in the high security system, resetting

the password monthly or weekly can better protect your product.

User Mame: admin
Password: ssssssse

Strong

Valid password range [8-16]. You can
use a combination of numbers,
lowercase, uppercase and special
character for your password with at least
two kinds of them contained.

Confirm Password: sssessss

Click OK to create the password for the device. A “The device is activated.” window pops up
when the password is set successfully.

Click Modify Netinfo to pop up the Modify Network Parameter interface.

Note: This function is only available on the Online Device area. You can change the device IP
address to the same subnet with your computer if you need to add the device to the software.
Change the device IP address to the same subnet with your computer by either modifying the IP
address manually or checking the checkbox of DHCP.

Input the password set in step 4 and click OK to complete the network settings.
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Modify Network Parameter x

Device Information:

MAC Address: 44-19-b7-2f-be-48 Copy
Software Version: V5.1.0build 131202 Copy
Device Serial No.: DS-2CD2412F-IW20140118CCCH450047294 Copy
MNetwork Information:

DHCP
Port: 2000

" IPvd(Dont Save)

IP Address: 10.16.1.251

Subnet Mask: 255.255.255.0

Gateway: 10.16.1.254
IPvE(Dont Save)

Password: ssssssse

3.1.2 Adding Online Devices

Purpose:

The active online devices in the same local subnet with the client software will be displayed on the
Online Device area. You can click the Refresh Every 60s button to refresh the information of the
online devices.

Note: You can click to hide the Online Device area.

Online Device (4) 4% Refresh Every 60s

o Addto Client <= AddAll [ Modify Netinfo %4 ResetPassword Activate Filter
P 4 | Device Type Firmware Version Security Server Port | Start Time Ach
10.16.1.102 DSI-670THFHN V1.0.0build 150730 Active 8000 2015-08-17 14:57:51 N(U
192.168.1.64 DS-2ZMN3008(YF) V5.3.0build 150323 Inactive 8000 2015-08-17 16:01:02 Mc
10.16.1.93 V5.3.10build 150729 Active 8000 2015-08-17 09:02:35 Me -
4 v

Steps:
1. Select the devices to be added from the list.
Note: For the inactive device, you need to create the password for it before you can add the
device properly. For detailed steps, please refer to Chapter 3.1.1 Creating the Password.
2. Click Add to Client to open the device adding dialog box.
Input the required information.
Nickname: Edit a name for the device as you want.
Address: Input the device’s IP address. The IP address of the device is obtained automatically in
this adding mode.
Port: Input the device port No.. The default value is 8000.
User Name: Input the device user name. By default, the user name is admin.

Password: Input the device password.

15
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The password strength of the device can be checked by the software. For your privacy, we strongly
recommend changing the password to something of your own choosing (using a minimum of 8
characters, including upper case letters, lower case letters, numbers, and special characters) in
order to increase the security of your product. And we recommend you reset your password
regularly, especially in the high security system, resetting the password monthly or weekly can
better protect your product.

4. Optionally, you can check the checkbox Export to Group to create a group by the device name. All
the channels of the device will be imported to the corresponding group by default.
Note: Guarding Expert also provides a method to add the offline devices. Check the checkbox Add
Offline Device, input the required information and the device channel number and alarm input
number, and then click Add. When the offline device comes online, the software will connect it
automatically.

5. Click Add to add the device.

Adding Mode

® |P/Domain IP Segment IP Server HIDDNS Batch Import Other Client

Add Offline Device

Nickname: [| ]

Address: 10.16.1.102
Port 8000
User Name

Password:

~/ Exportto Group

Setthe device name as the group name and add all the channels
connected to the device to the group.

Add Multiple Online Devices

If you want to add multiple online devices to the client software, click and hold Ctrl key to select
multiple devices, and click Add to Client to open the device adding dialog box. In the pop-up message

box, enter the user name and password for the devices to be added.

Add All the Online Devices

If you want to add all the online devices to the client software, click Add All and click OK in the pop-up

message box. Then enter the user name and password for the devices to be added.
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Adding Mode

® |P/Domain IP Segment IP Server HIDDNS Batch Import Other Client

User Name: [| ]

Password:

~ Exportto Group

Create group with device IP.

Modify Network Information

Select the device from the list, click Modify Netinfo, and then you can modify the network
information of the selected device.
Note: You should enter the admin password the device in the Password field of the pop-up window to

modify the parameters.

Reset Password

According to the different devices, the software provides three different methods for restoring the
default password or resetting the password.

Select the device from the list, click Reset Password.

Option 1:

If the window with security code field pops up, input the security code, and then you can restore the
default password of the selected device.

Note: The security code is returned after you send the data and serial No. of the device to the
manufacturer.

Option 2:

If the window with import file and export file buttons pops up, perform the following steps to restore
the default password:

1. Click Export to save the device file on your PC.

2. Send the file to our technical engineers.

3.  Click Import and select the file received from the technical engineer.

4

Click OK to restore the default password of the device.

@ The default password (12345) for the Admin account is for first-time log-in purposes only. You
must change this default password to better protect against security risks, such as the
unauthorized access by others to the product that may prevent the product from functioning
properly and/or lead to other undesirable consequences.

@ For your privacy, we strongly recommend changing the password to something of your own
17
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choosing (using a minimum of 8 characters, including upper case letters, lower case letters,
numbers, and special characters) in order to increase the security of your product.
@ Proper configuration of all passwords and other security settings is the responsibility of the

installer and/or end-user.

Option 3:

If the window with import file and export file buttons, password and confirm password field pops up,

follow the steps below to reset the password:

1. Click Export to save the device file on your PC.
2. Send the file to our technical engineers.
3. Our technical engineer will send you a file or an eight-digit number to you.
® [f you receive a file from the technical engineer, select Import File from Key Importing
Mode drop-down list and click | to import the file.
® If you receive an eight-digit number from the technical engineer, select Input Key from Key
Importing Mode drop-down list and input the number.
Input new password in text fields of Password and Confirm Password.
Click OK to reset the password.
The password strength of the device can be checked by the software. For your privacy, we
strongly recommend changing the password to something of your own choosing (using a
minimum of 8 characters, including upper case letters, lower case letters, numbers, and special
characters) in order to increase the security of your product. And we recommend you reset your
password regularly, especially in the high security system, resetting the password monthly or
weekly can better protect your product.
Option 4:

If the dialog with Generate buttons, password and confirm password field pops up, follow the steps

below to reset the password:

1.
2.

Click Generate to pop up the QR Code dialog.

Click Download and select a saving path to save the QR code to your PC. You can also take a
photo of the QR code to save it to your phone.

Send the picture to our technical engineers and you will receive an eight-digit number from the
technical engineer

Select Input Key from Key Importing Mode drop-down list and input the number.

Input new password in text fields of Password and Confirm Password.

Click OK to reset the password.

The password strength of the device can be checked by the software. For your privacy, we
strongly recommend changing the password to something of your own choosing (using a
minimum of 8 characters, including upper case letters, lower case letters, numbers, and special
characters) in order to increase the security of your product. And we recommend you reset your

password regularly, especially in the high security system, resetting the password monthly or
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weekly can better protect your product.

Synchronizing the Password

Purpose:

You can reset the password for the NVR or HDVR and use the new password as the password of the
connected network cameras and encoders.

Note: This function should be supported by the device.

Steps:

1. Select a device on the Online Device panel and click Reset Password.

2.  Perform the password reset steps and check Use New Password as Camera Password checkbox.
3.  Click OK to save the settings.

3.1.3 Adding Devices Manually

Steps:
1. Click Add Device to open the device adding dialog box.
2. Select IP/Domain as the adding mode.
3. Input the required information.
Nickname: Edit a name for the device as you want.
Address: Input the device’s IP address or domain name.
Port: Input the device port No.. The default value is 8000.
User Name: Input the device user name. By default, the user name is admin.

Password: Input the device password.

The password strength of the device can be checked by the software. For your privacy, we strongly
recommend changing the password to something of your own choosing (using a minimum of 8
characters, including upper case letters, lower case letters, numbers, and special characters) in
order to increase the security of your product. And we recommend you reset your password
regularly, especially in the high security system, resetting the password monthly or weekly can
better protect your product.

4. Optionally, you can check the checkbox Export to Group to create a group by the device name. All
the channels of the device will be imported to the corresponding group by default.
Note: Guarding Expert also provides a method to add the offline devices. Check the checkbox Add
Offline Device, input the required information and the device channel number and alarm input
number, and then click Add. When the offline device comes online, the software will connect it
automatically.

5. Click Add to add the device.
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Adding Mode

® |P/Domain IP Segment IP Server HIDDNS Batch Import Other Client

Add Offline Device

Nickname: [| ]

Address:
Port 8000
User Name

Password:

~/ Exportto Group

Setthe device name as the group name and add all the channels
connected to the device to the group.

3.1.4 Adding Devices by IP Segment

Steps:

1.
2.
3.

Click Add Device to open the device adding dialog box.

Select IP Segment as the adding mode.

Input the required information.

Start IP: Input a start IP address.

End IP: Input an end IP address in the same network segment with the start IP.
Port: Input the device port No.. The default value is 8000.

User Name: Input the device user name. By default, the user name is admin.

Password: Input the device password.

The password strength of the device can be checked by the software. For your privacy, we strongly
recommend changing the password to something of your own choosing (using a minimum of 8
characters, including upper case letters, lower case letters, numbers, and special characters) in
order to increase the security of your product. And we recommend you reset your password
regularly, especially in the high security system, resetting the password monthly or weekly can
better protect your product.

Optionally, you can check the checkbox Export to Group to create a group by the device IP. All the
channels of the device will be imported to the corresponding group by default.

Note: Guarding Expert also provides a method to add the offline devices. Check the checkbox Add
Offline Device, input the required information and the device channel number and alarm input
number, and then click Add. When the offline device comes online, the software will connect it
automatically.

Click Add, and the device of which the IP address is between the start IP and end IP will be added

to the device list.
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Adding Mode

IPiDomain @ IP Segment IP Server HIDDNS Batch Import Other Client

Add Offline Device

Start P [101511\ ]

End IP: 10.16.1.10
Port 8000
User Name

Password:

~/ Exportto Group

Create group with device IP.

3.1.5 Adding Devices by IP Server

Steps:

1.
2.
3.

Click Add Device to open the device adding dialog box.

Select IP Server as the adding mode.

Input the required information.

Nickname: Edit a name for the device as you want.

Server Address: Input the IP address of the PC that installs the IP Server.
Device ID: Input the device ID registered on the IP Server.

User Name: Input the device user name. By default, the user name is admin.

Password: Input the device password.

The password strength of the device can be checked by the software. For your privacy, we strongly
recommend changing the password to something of your own choosing (using a minimum of 8
characters, including upper case letters, lower case letters, numbers, and special characters) in
order to increase the security of your product. And we recommend you reset your password
regularly, especially in the high security system, resetting the password monthly or weekly can
better protect your product.

Optionally, you can check the checkbox Export to Group to create a group by the device name. All
the channels of the device will be imported to the corresponding group by default.

Note: Guarding Expert also provides a method to add the offline devices. Check the checkbox Add
Offline Device, input the required information and the device channel number and alarm input
number, and then click Add. When the offline device comes online, the software will connect it
automatically.

Click Add to add the device.

21



User Manual of Guarding Expert

Adding Mode

IPiDomain IP Segment @ IP Server HIDDNS Batch Import Other Client

Add Offline Device

Nickname: [| ]

Server Address
Device ID
User Name

Password:

~/ Exportto Group

Setthe device name as the group name and add all the channels
connected to the device to the group.

3.1.6 Adding Devices by HIDDNS

Steps:

1.
2.
3.

Click Add Device to open the device adding dialog box.

Select HIDDNS as the adding mode.

Input the required information.

Nickname: Edit a name for the device as you want.

Server Address: www.hiddns.com.

Device Domain Name: Input the device domain name registered on HiDDNS server.
User Name: Input the device user name. By default, the user name is admin.

Password: Input the device password.

The password strength of the device can be checked by the software. For your privacy, we strongly
recommend changing the password to something of your own choosing (using a minimum of 8
characters, including upper case letters, lower case letters, numbers, and special characters) in
order to increase the security of your product. And we recommend you reset your password
regularly, especially in the high security system, resetting the password monthly or weekly can
better protect your product.

Optionally, you can check the checkbox Export to Group to create a group by the device name. All
the channels of the device will be imported to the corresponding group by default.

Note: Guarding Expert also provides a method to add the offline devices. Check the checkbox Add
Offline Device, input the required information and the device channel number and alarm input
number, and then click Add. When the offline device comes online, the software will connect it
automatically.

Click Add to add the device.
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Adding Mode

IF/Domain IP Segment IP Server  ®) HIDDNS Batch Import Other Client
Add Offline Device

Mickname: My DVR

Server Address www hiddns.com

Device Domain Name:  Front Door

User Name admin

Password: ["""“l ]

~/ Exportto Group

Setthe device name as the group name and add all the channels
connected to the device to the group.

3.1.7 Batch Adding Devices

Purpose:

The devices can be added to the software in batch by inputting the device information in the

pre-defined CSV file.

Steps:

1. Click Add Device to open the device adding dialog box.

2.  Select Batch Import as the adding mode.

3.  Click Export Template and save the pre-defined template (CSV file) on your PC.

4. Open the exported template file and input the required information of the devices to be added
on the corresponding column.
Nickname: Edit a name for the device as you want.
Adding Mode: You can input 0, 2, or 3 which indicated different adding modes. 0 indicates that
the device is added by IP address or domain name; 2 indicates that the device is added via IP
server; 3 indicates that the device is added via HiDDNS.
Address: Edit the address of the device. If you set 0 as the adding mode, you should input the IP
address or domain name of the device; if you set 2 as the adding mode, you should input the IP
address of the PC that installs the IP Server; if you set 3 as the adding mode, you should input
www.hiddns.com.
Port: Input the device port No.. The default value is 8000.
Device Information: If you set 0 as the adding mode, this field is not required; if you set 2 as the
adding mode, input the device ID registered on the IP Server; if you set 3 as the adding mode,
input the device domain name registered on HiDDNS server.
User Name: Input the device user name. By default, the user name is admin.

Password: Input the device password.

The password strength of the device can be checked by the software. For your privacy, we
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strongly recommend changing the password to something of your own choosing (using a
minimum of 8 characters, including upper case letters, lower case letters, numbers, and special
characters) in order to increase the security of your product. And we recommend you reset your
password regularly, especially in the high security system, resetting the password monthly or
weekly can better protect your product.
Add Offline Device: You can input 1 to enable adding the offline device, and then the software
will automatically connect it when the offline device comes online. 0 indicates disabling this
function.
Export to Group: You can input 1 to create a group by the device name (nickname). All the
channels of the device will be imported to the corresponding group by default. 0 indicates
disabling this function.
Channel Number: If you set 1 for Add Offline Device, input the channel number of the device. If
you set 0 for Add Offline Device, this field is not required.
Alarm Input Number: If you set 1 for Add Offline Device, input the alarm input number of the
device. If you set 0 for Add Offline Device, this field is not required.

5. Click "' and select the template file.
Click Add to import the devices.

Adding Mode
IF/Domain IP Segment IP Server HIDDMS  ® Batch Import Other Client
File (*.csv):
Export Template

The devices will be displayed on the device list for management after added successfully. You can
check the resource usage, HDD status, recording status, and other information of the added devices
on the list.

Click Refresh All to refresh the information of all added devices. You can also input the device name in
the filter field for search.

Select device from the list, click Modify/Delete, and then you can modify/delete the information of
the selected device.

Select device from the list, click Remote Configuration, and then you can do some remote
configurations of the selected device if needed. For detailed settings about the remote configuration,

please refer to the User Manual of the devices.
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3.1.8 QR Code of Encoding Devices

Purpose:
For encoding devices, the QR code of the devices can be generated. You can add the device to your
mobile client software by using the mobile client software to scan the QR code. For adding the devices

to your mobile client software, please refer to the User Manual of the mobile client software.

Check the QR Code

On the device list, double-click a device, the information and QR code of the device will be displayed.
Or you can click to select a device and click QR Code to pop up the QR code window of the device.
You can also click and hold the Ctrl key to select multiple devices, and click QR Code to pop up the QR
code window of the devices. In this way, you can add multiple devices at the same time by scanning
the QR code.

Adding Mode:

@) IPiDomain IP Segment IP Server HIDDNS Batch Import Other Client

Nickname: [EE ] QR Code x

Address: 172.10.21.191

Port: 8000

User Mame test

Password: asassssne

3.1.9 Checking Device’s Online Users

Purpose:

When any user accesses the device, the client can record and show the connection information,
including user name, user type, user’s IP address, and login time.

Note: This function should be supported by the device.

Steps:

1. Click to select an added and online device.

2.  Click Online Users to pop up the Online Users dialog.
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User List

Index

4

User Name

admin

admin

admin

admin

User Type

Administrator
Administrator
Administrator

Administrator

IP Address

10.16.1.103

10.10.1.244

10.16.2.15

10.16.1.20

User Login Time

20151124 01:43:43
20151124 01:11:37
201511 24 01:32:40

201511 23 23:48:20

3. Check the information of the users that log into the device.
4. Click OK to close the dialog.

3.2 Group Management

Purpose:

The devices added should be organized into groups for a convenient management. You can get the live

view, play back the video files, and do some other operations of the device through the group.

Before you start:

Devices need to be added to the client software for group management.

Perform the following steps to enter the Group Management interface:

1. Open the Device Management page.

2. Click the Group tab to enter the Group Management interface.

2= Sever W Group

Resource

Search

Alarm Input

Arming Region Resource

—J Group_1

2

[+ B FFFF R E R

— 10.6.6.133
/1066134
— 10.6.6.135
/1066136
) 1066137
) 10.6.6.140
1066142
— 10.6.6.143

1066146

= Intersection

Alarm Input

Arming Regien Resource

[+ [+

110735223

110333159

Adding the Group

Steps:

Encoding Channel Resources of Group Intersection(10)

o Import [ Modify
Nickname
IP Camerat_lntersection
IP Camera2_Intersection
IP Camera3_lIntersection
IP Camerad_Intersection
IP Camera5_Intersection
IP Camerat_Intersection
IP Camera7_Intersection
IP CameraB_lntersection
IP Camerad_lIntersection

IP Camera10_Intersection

X Delete % Remote Confi

1. Click - to open the Add Group dialog box.

~|P
10.99.105.140
10.99.105.140
10.99.105.140
10.99.105.140
10.99.105.140
10.99.105.140
10.99.105.140
10.99.105.140
10.99.105.140
10.99.105.140

Filter

Device Serial No.

DS-9616N-ST1620130301BBRR4071293...
DS-9616N-5T1620130301BBRR4071293
DS-9616N-ST1620130301BBRR4071293
DS-9616N-5T1620130301BBRR4071293..
DS-9616N-ST1620130301BBRR4071293
DS-9616N-5T1620130301BBRR4071293..
DS-9616N-5T1620130301BBRR4071293
DS-9616N-5T1620130301BBRR4071293..
DS-9616N-5T1620130301BBRR4071293

DS-9616N-ST1620130301BBRR4071293
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2. Input a group name as you want.
Click OK to add the new group to the group list.
You can also check the checkbox Create Group by Device Name to create the new group by the

name of the selected device.

Add Group

Group Name: [

Create Group by Device Mame

Importing Encoding Device to Group

Steps:
1. Click Import on Group Management interface, and then click the Encoding Channel tab to open
the Import Encoding Channel page.
Note: You can also select Alarm Input tab and import the alarm inputs to group.
2. Select the thumbnails/names of the cameras in the thumbnail/list view.
Select a group from the group list.
4. Click Import to import the selected cameras to the group.
You can also click Import All to import all the cameras to a selected group.
Notes:

® You can also click the icon " on the Import Encoding Channel page to add a new group.
® Up to 256 cameras can be added to one group.

™m Encoding Channel | A5 Alarminput B8 Zone [ Access Control
Select Device All v
Encoding Channel B== N 2 Group +*
Search P
— e L mssisvicangCmd
: B
& Camersl 10161250
4 1061110-Encoding Channel
+ ' 10461.72-Encoding Channel
10.16.1.72 23 =1 6
+ 1 10161102-Encoding Channel
10.16.1.102 [ ¥
= + . POS-Encoding Channel
TEEEED 4 =1 G 4 1 172.1018.77-Encoding Channel
POS =3 =1 B meort 1 172.1018.29-Encoding Channel
TR = B0 Imiort All . Attendance-Encoding Channel
oAt N B O . Security Control Panel-Encoding Channel
4 1 10333159-Encoding Channel
10.16.1.107 o - =
10.33.3.159 ola]=
[ 2

The following buttons are available on the Import Encoding Channel page:

oEE List View View the camera in list view.
-l

0 Thumbnail View View the camera in thumbnail view.
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&

Refresh Refresh the latest information of added cameras.

" Import Create a group named as device name-Encoding Channel
(Alarm Input) and import the device to group.

Collapse/Expand Collapse/Expand the thumbnails of cameras.

»
&«

Modifying the Group/Camera

Steps:

1.

Select the group/camera from the group list on the Import page.
Move the mouse to the camera/group and click @ or double-click the group/camera name to

open Modify Group/Camera dialog box.

2. Edit the group/camera information, including the group/camera name, the stream type, etc.
Video Stream: Select the stream for the live view or playback of the camera as desired.
Rotate Type: Select the rotate type for the live view or playback of the camera as desired.
Protocol Type: Select the transmission protocol for the camera.
Stream Media Server: Configure to get stream of the camera via stream media server. You can
select and manage the available stream media server.
Copy to...: Copy the configured parameters to other camera(s).
Refresh: Get a new captured picture for the live view of the camera.
Note: For video stream and protocol type, the new settings will take effect after you reopen the
live view of the camera.
3. Click OK to save the new settings.
You can also double click the encoding channel on the Resource list in the Group Management
interface after encoding channels encoded, or select the encoding channel and click [ Modily| 4,
open the Modify Camera dialog box.
Name:
Video Stream:
Main Stream v
Rotate Type
Normal v
Protocol Type:
TCP |v
Stream Media Server
Modity Group i, A SMS Management
b W i Copy Parameters:
1 ' | Get New Picture:
Refresh
p——
Notes:

For the IP channel of NVR which supports decoding function:

After decoding and displaying on video wall, there will be a new channel in the Encoding Channel
Resources list whose protocol type is decoding on video wall.
After closing the corresponding roaming window, the new channel will be removed from the

Encoding Channel Resources list.
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Removing Cameras from the Group

Steps:

1. Select the camera from the group list on the Import Encoding Channel page.

2. Move the mouse to the camera and click * to remove the camera from the group.
You can also select the camera on the Group Management interface, and then click Delete to
remove the camera from the group.

3. Select the group from the group list on the Import Encoding Channel page, move the mouse to

the group and click * and you can remove all the cameras from the group.

Deleting the Group

Steps:
1. Select the group on the Group Management interface
2. Click Delete Group, or move the mouse to the group and click the icon %, the selected group

and the resource under it will be deleted.
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Purpose:

Chapter 4 Live View

For the surveillance task, you can view the live video of the added network cameras, video encoders

and video intercom device on the Main View page. And some basic operations are supported,

including picture capturing, manual recording, PTZ control, etc.

Before you start:

A camera group is required to be defined for live view.

You can set the rotate type if necessary in the Group Management. For details, refer to Modifying the

Group/Camera of Chapter 3.2 Group Management.

Click the F icon on the control panel,

or click View->Main View to open the Main View page.

View
Search. P
L s
I 1-Screen U
I 4-screen

Camera

Search P

£ 10.6.6.133

21 10.66.134 2

PTZ Control

LN (K

vial |+
« 101> )+
o

bY 4

(2 S ]

- - +
&« o3¢\v
Preset Pattern Patrol
T

01 Preset1

02 Preset2

Preset3

LIRS B2

[+
[+
®
=

Main View Page
1 View List

2 Camera List
3 PTZ Control Panel
4 Display Window of Live View

5 Live View Toolbar

Camera Status:

®
a
&
&

Notes:

The camera is online and works properly.
The camera is in live view.
The camera is in recording status.

The camera is offline.

® |[f event (e.g., motion detection) is detected for the camera, the camera icon will display as 5
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and the group icon will show as %1,
® [f the camera is offling, the client can still get the live video via the stream media server if the

stream media server is configured. The camera icon will display as #. For configuring the
stream media server of the camera, refer to Chapter 11 Forwarding Video Stream through

Stream Media Server.

Live View Toolbar:

On the Main View page, the following toolbar buttons are available:

=) Save View Save the new settings for the current view.

=5 Save View as Save the current view as another new view.

] Stop Live View Stop the live view of all cameras.

(S )] Mute/Audio On Turn off/on the audio in live view

G Resume/Pause Click to resume/pause the auto-switch in live view.

Auto-switch

Show/Hide the configuration menu of auto-switch. Click again

- Show/Hide the Menu
to hide.

4= Previous Go for live view of the previous page.

L Next Go for live view of the next page.

B Window Division Set the window division.
Display the live view in full-screen mode.
Press Esc, or you can move the mouse to the top of the screen
and click Quit Full Screen button to exit.

= Full Screen You can click Lock button to lock the screen, and you can click

Unlock and input the client admin password to unlock it.
For full screen auto-switch, you can click Previous or Next

button to view the previous or next camera.

Right-click on the display window in live view to open the Live View Management Menu:

= Stop Live View

i Capture

o Other Capture Modes 4
o Start Recording

& Open PTZ Control

&, Open Digital Zoom

Q, Enable Auto-tracking

@ Switch to Instant Playback >

Fire Source Information >

@ Start Two-way Audio
&2 Enable Audio

| Camera Status

& Remote Configuration

?— Synchronization

&/ Fisheye Expansion

.“? Start Master-slave Linkage

@ Unlock
=, Full Screen

The following buttons are available on the right-click Live View Management Menu:
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o ©

2

4k

E

[0l

o

5 4 &

3]
o

o

=)

Stop Live View

Capture

Other Capture Modes

Start/Stop Recording

Open PTZ Control

Open Digital Zoom

Enable Auto-tracking

Switch to Instant
Playback

Fire Source Information

Start/Stop Two-way
Audio

Start/Stop IP Two-way
Audio

Enable/Disable Audio
Camera Status
Remote Configuration

VCA Configuration

Synchronization

Fisheye Expansion

Start/Stop Master-slave
Linkage

Unlock

Stop the live view in the display window.

Capture the picture in the live view process.

Print Captured Picture: Capture a picture and print it.

Send Email: Capture the current picture and then send an Email
notification to one or more receivers. The captured picture can be
attached.

Custom Capture: Capture the current picture. You can edit its
name and then save it.

Start/Stop the manual recording. The video file is stored in the PC.
Enable PTZ control function on the display window. Click again to
disable the function.

Enable the digital zoom function. Click again to disable the
function.

Enable the auto-tracking function of the speed dome. Then the
speed dome will track the object appearing on the video
automatically. This button is only available for the speed dome

that supports the auto-tracking function.
Switch to instant playback mode.

For thermal camera, click to display the fire source region, display
the maximum temperature information, locate the maximum

temperature region, or display the fire source target.
Click to start/stop the two-way audio with the device in live view.

Click to start/stop the two-way audio with the camera in live view.
This button is only available for the camera that supports the IP
two-way audio function.

Click to enable/disable the audio in live view.

Display the status of the camera in live view, including the
recording status, signal status, connection number, etc.

Open the remote configuration page of the camera in live view.
Enter the VCA configuration interface of the device if it is VCA
device.

Sync the camera in live view with the PC running the client
software.

Enter the fisheye expansion mode. Only available when the device
is fisheye camera. For details, please refer to Chapter 4.7 Live View
in Fisheye Mode.

Click to start/stop locating or tracking the target according to your
demand. Only available when the device is fisheye camera or
box/bullet camera. For details, please refer to Chapter 4.8 Starting

Master-slave Linkage.

Click to remote unlock the door if the device is door station, outer
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door station or door station (V series).

Display the live view in full screen mode. Click the icon again to
= Full Screen ]
exit.

4.1 Starting and Stopping the Live View

Starting Live View for One Camera

Steps:
1. Open the Main View page.
2. Optionally, click the [ icon in live view toolbar to select the window division mode for live view.
3. Click-and-drag the camera to the display window,
or double-click the camera name after selecting the display window to start the live view.
Note: You can click-and-drag the video of the camera in live view to another display window if

needed.

Starting Live View for Camera Group

Steps:
1. Open the Main View page.
2. Click-and-drag the group to the display window,
or double-click the group name to start the live view.

Note: The display window number is self-adaptive to the camera number of the group.

Starting Live View in Default View Mode

Purpose:

The video of the added cameras can be displayed in different view modes. 4 frequently-used default
view modes are selectable: 1-Screen, 4-Screen, 9-Screen and 16-Screen.

Steps:

1. Open the Main View page.

+

2. Inthe View panel, click the icon to expand the default view list.
3. Click to select the default view mode and the video of the added cameras will be displayed in a
sequence in the selected view.
Note: Click El'é’ and you can save the default view as a custom view.
Move the mouse to the view and the following icons are available:
Start Instant Playback  Start the instant playback of the view.
Start switching automatically of the view. For details,

¥y  Start Auto-switch o )
please refer to Chapter 4.2 Auto-switch in Live View.
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View ~
Search... o
Ll 1-Screen ¥
|l 4-Screen
|| 9-Screen
&8 16-Screen

B Custom View

Starting Live View in Custom View Mode

Purpose:

The view mode can also be customized for the video live view.

Steps:

1. Open the Main View page.

2. Inthe View panel, click theicon '* ' to expand the custom view list. If there is custom view
available, you can click to start live view of the custom view.

3. Click to create a new view.

4. Input the view name and click Add. The new view is of 4-Screen mode by default.

5. Optionally, click the [ jcon in live view toolbar and select the screen layout mode for the new
view.

6. Click-and-drag the camera/group to the display window,
or double-click the camera/group name in custom view mode to start the live view.

7. Click theicon B to save the new view. You can also click H& to save the view as another

custom view.

Move the mouse to the custom view and the following icons are available:

b 4

Edit View Name Edit the name of the custom view.
Delete View Delete the custom view.

Start Instant Playback Start the instant playback of the view.

View -~
Search... o]

- B Default View

| 1-Screen

ol 4-Screen

| 9-Screen

e 16-Screen

- B Custom View
E2 £SO
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Stopping the Live View

Steps:

1. Select the display window.

2. Click the icon . that appears in the upper-right corner when the mouse pointer is over the
display window,
or click Stop Live View on the right-click menu to stop the live view of the display window.

You can also click the button ™ in live view toolbar to stop all the live view.

4.2 Auto-switch in Live View

Camera Auto-switch

Purpose:

The video stream of the cameras from the same group will switch automatically in a selected display
window in camera auto-switch.

Steps:

Open the Main View page.

Select a display window for camera auto-switch.

-

Click the icon in the toolbar and select or customize the switching interval.
Select a group and click the icon "> on the group node.

You can click the icon (i /O to pause/resume the camera auto-switch.

oV ks~ W N PR

You can click € or 2] to view the live video of previous or next camera.

Single View Auto-switch

Purpose:

The video of all the cameras on the camera list will switch automatically in a selected default view in
single view auto-switch.

Steps:

1. Open the Main View page.

-

Click the icon in the toolbar and select or customize the switching interval.
Select a default view and click the icon "~ on the selected view node.

You can click the icon (i /O to pause/resume the single view auto-switch.

vk W

You can click €/ or 2 to view the live video of previous or next camera.

Multi-view Auto-switch

Purpose:

The custom views will switch automatically in multi-view auto-switch. The custom views need to be
added before proceeding.

Steps:

1. Open the Main View page.

2. Click theicon = in the toolbar and select the switching interval.

3. Click theicon "™ on the custom view node.

35



User Manual of Guarding Expert

4. You can click the icon G /0 to pause/resume the multi-view auto-switch.

5. Youcan click £ or 2 to view the live video of previous or next camera.

4.3 PTZ Control in Live View

The software provides PTZ control for cameras with pan/tilt/zoom functionality. You can set the preset,
patrol and pattern for the cameras on the PTZ Control panel. And you can also open window PTZ
control for the operations of PTZ cameras.

Click the icon ® to expand the PTZ Control panel.
PTZ Control ~

v Y v + Q
« | U |+ & -
e

s v 4 +

B =il e @@ »

Preset Pattern Patrol
W B X
01 Presetd |'.'|
02 Preset2 I
03 Preset3

The following buttons are available on the PTZ Control panel:

Q Zoom
o Focus
Q Iris
@ 3D Positioning
i Auxiliary Focus
i Lens Initialization
¢ Light
0\ 2 Wiper
EY Manual Tracking
= Menu
< One-touch Patrol
i One-touch Park
Notes:
®  For the analog speed dome, you can click = to display its local menu. For detailed operation of

the menu, please refer to the User Manual of the speed dome.

® For the speed dome with auto-tracking function, you can enable the auto-tracking (via right-click
menu) for it and then click & to manually track the target by clicking on the video.

® For the one-touch patrol function, you can click 2| andthe speed dome will start patrol from
the predefined preset No.1 to preset No.32 in order after a period of inactivity (park time). For
setting the park time, please refer to the User Manual of the speed dome.

® For the speed dome with one-touch park function, you can enable the one-touch park by clicking

k andthe speed dome will save the current view to the preset No.32. The device starts to park
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at preset No. 32 automatically after a period of inactivity (park time). For setting the parking time,

please refer to the User Manual of the speed dome.

Configuring the Preset

A preset is a predefined image position which contains information of pan, tilt, focus and other

parameters.

Perform the following steps to add a preset:

1. Click the Preset button to enter the PTZ preset configuration panel.

2. Click the direction buttons and other buttons on the PTZ control panel to steer the camera to the
desired view.

3. Select a PTZ preset number from the preset list and click 2
Input the name of the preset in the pop-up dialog box.

Click OK to save the settings.

To call a configured preset, double-click the preset, or select the preset and click the icon Q.
You also perform the following steps to call the preset.

Steps:

1. Click to select a live view window.

2. Forpreset1to9, click the corresponding number key (e.g., 4) to call the preset.

ll] ”

For other presets, click “[”, number keys (e.g., 124), and “]” to call the preset.
To modify a configured preset, select the preset from the list and click the icon &

To delete a configured preset, select the preset from the list and click the icon ®

PTZ Contral ~

Q
« U o o+ M -
4]

< lle w3y = o>

Add Preset

Preset Pattern Patral
0 & x
01 1 o

02 Preset2

03 Preset3

Configuring the Pattern

A pattern is a memorized, repeating series of pan, tilt, zoom, and preset functions.
Perform the following steps to add a pattern:

Click the Pattern button to enter the PTZ pattern configuration panel.

Click E to start recording of this pattern path.

Use the direction buttons to control the PTZ movement.

Click n to stop and save the pattern recording.
Click the icon I to call the pattern. To stop calling the pattern, click =}

o Uk wnN e

(Optional) You can click # to delete the selected pattern.
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Click B to delete all the patterns.
PTZ Control ~

Gl || 5| = >

Preset Pattern Patrol

L[v@O©OO xm

Configuring the Patrol

A patrol is a scanning track specified by a group of user-defined presets, with the scanning speed
between two presets and the dwell time at the preset separately programmable.

Before you start:

Two or more presets for one PTZ camera need to be added.

Perform the following steps to add and call a patrol:

Click the Patrol button to enter the PTZ patrol configuration panel.

Select a track number from the drop-down list.

Click * toadda preset, and set the dwell time and patrol speed for the preset.

Repeat the above operation to add other presets to the patrol.

Optionally, you can click # or B to edit or delete a preset in the patrol path.
Click the icon @ to call the patrol. To stop calling the patrol, click &.

ok w N R

Note: The preset dwell time can be set to 1 to 30 sec, and the patrol speed can be set to level 1 to 40.

PTZ Contral ~

v A v +

» v 4 + =

Add Patrol No x
— — +

o
« ||| > ||+ k|-
e

IR =) e )2
Preset: Preset1 v
Preset Pattern Patrol S .
Dwell Time(s): |{ =
Path 1 - (P
Patrol Speed: 1 .
M1 Preset1 2s 30 B 4
+

4.4 Manual Recording and Capture

Toolbar in Each Live View Display Window:
BQisQABRC
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In each live view display window, the following toolbar buttons are available:

] Stop Live View Stop the live view in the display window.

i Capture the picture in the live view process. The capture picture
o1 Capture

is stored in the PC.
o @ Start/Stop Recording Start/Stop manual recording. The video file is stored in the PC.
Start/Stop PTZ mode for speed dome. Click and drag in the view
A Open/Close PTZ Control
to perform the PTZ control.

Start/Stop Two-way ] o o
Click to start/stop the two-way audio with the device in live view.

R

Audio
a Open/Close Digital Enable the digital zoom function. Click again to disable the
Zoom function.
Switch to Instant ) ]
@ Switch to the instant playback mode.
Playback
© Remote Configuration Open the remote configuration page of the camera in live view.

Note: You can customize the icons and the icons’ order as desired in System Configuration. For details,

refer to Chapter 17.2.5 Toolbar Settings.

Manual Recording in Live View

Purpose:

Manual Recording function allows you to record the live video on the Main View page manually and

the video files are stored in the local PC.

Steps:

1. Move the mouse pointer to the display window in live view to show the toolbar.

2. Click O in the toolbar of the display window or on the right-click Live View Management Menu
to start the manual recording. The icon O turns to .

3. Click theicon to stop the manual recording.
A prompt box with the saving path of the video files you just recorded will pop up if all the

operations succeed.

Notes:

® During the manual recording, an indicator ﬁ appears in the upper-right corner of the display
window.

® The saving path of video files can be set on the System Configuration interface. For details, see
Section 17.2.4 File Saving Path Settings.

® For Cloud P2P device, the manual recording is not supported during live view.

Viewing Local Video Files

Steps:

1. Click File->Open Video File to open the Video Files page.

2. Select the camera to be searched from the Camera Group list.

3. Click theicon ﬂ to specify the start time and end time for the search.

4. Click Search. The video files recorded between the start time and end time will be displayed.
Select the video file, and click Delete. You can delete the video file.
Select the video file, and click Send Email. You can send an Email notification with the selected

video file attached.
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Select the video file, and click Save as. You can save a new copy of the video file.

Note: To send an Email notification, the Email settings need to be configured before proceeding. For

details, see Section 17.2.8 Email Settings.

Camera Group
Search 2

DR=R

) 1 Intersection

Start Time:
2015-08-31 00:00:00 |
End Time:

2015-08-31 23:59:59 e

Video Files

€ Delete [ SendEmail | Saveas

Double-click the video file and the video file can be played back locally.

—— = —

= 7
) i e e 2l

00:00:05/00:02:24

The following buttons are available on the local playback page:

it | CIF/4CIF

Full Screen

n Close

L Bl  Pause/Play

ﬁ Stop

Speed

ﬁ Single Frame

Digital Zoom
Enable/Disable Audio
ﬁ Capture

Display the video in cif/4cif resolution.

Display the local playback page in full screen mode.
Close the local playback page of the video files.
Pause/Start the playback of the video files.

Stop the playback of the video files.

Set the playback speed.

Play back the video files frame by frame.

Enable the digital zoom function. Click again to disable.
Click to enable/disable the audio in the local playback.
Capture the picture in the playback process.
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Capturing Picture in Live View

Steps:

1. Move the mouse pointer to the display window in live view to show the toolbar.

2. Clickthe B in the toolbar of the display window or on the right-click Live View Management
Menu.
A small window of the captured picture will be displayed to notify whether the capturing
operation is done or not.

Note: The saving path of the captured pictures can be set on the System Configuration interface. For

details, see Section 17.2.4 File Saving Path Settings.

Viewing Captured Pictures

The pictures captured in live view are stored in the PC running the software. You can view the
captured pictures if needed.

Steps:

1. Click File->Open Image File to open the Captured Images page.

Select the camera to be searched from the Camera Group list.

Click the icon [ to specify the start time and end time for the search.
Click Search. The pictures captured between the start time and end time will be displayed.

vk W

Double-click the captured picture to enlarge it for a better view.

Select the captured picture, and click Print. You can print the selected picture.

Select the captured picture, and click Delete. You can delete the selected picture.

Select the captured picture, and click Send Email. You can send an Email notification with the
selected picture attached.

Select the captured picture, and click Save as. You can save a new copy of the selected picture.

Camera Group Local Images (= Print ) Delete [ SendEmail i Save as
Search. 2] g e——— [ S
= &1
JSmezeion W
-

Start Time

2015-08-31 00:00:00 e

End Time:

2015-08-31 23:59:59 e

Q, search
)

4.5 Instant Playback

Purpose:

The video files can be played back instantly on the Main View page. Instant playback shows a piece of
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the video which was remarkable, or which was unclear on the first sight. Thus, you can get an

immediate review if needed.

Before you start:

The video files need to be recorded on the storage devices, such as the SD/SDHC cards and HDDs on

the DVRs, NVRs, Network Cameras, etc., or on the storage servers.

Steps:

1. Start the live view and move the mouse to the display window to show the toolbar. You can also
move the mouse to default view or custom view and click [ to enable the instant playback of
the selected view.

2. Click the icon % in the toolbar and a list of time periods pops up.
30s, 1 min, 3 min, 5 min, 8 min, and 10 min are selectable.

3. Select a time period to start the instant playback.

Example: If the current time of the live view is 09:30:00, and you select 3 min, then the instant
playback will start from 09:27:00.

4. Click theicon % again to stop the instant playback and go back for the live view.

Note: During the instant playback, an indicator E appears in the upper-right corner of the display
window.

& 1x

2014-12-" 20: 3 sA™== [PCanera

On the instant playback page, the following toolbar buttons are available:

L | Reverse Playback Play back the video file reversely.

il » Pause/Start Playback Pause/Start the playback of the video files.

|| Stop Playback Stop the playback of all cameras.

“ M Slow Forward/Fast Forward Decrease/Increase the play speed of the playback.
| Single Frame (Reverse) Play back the video files frame by frame (reversely).

Right-click on the display window to open the Instant Playback Management Menu:
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<« Reverse Play
11 Pause

= Stop

»» Fast Forward
«« Slow Forward
i» Single Frame

&_ Open Digital Zoom

Capture

&

© Start Recording
&2 Enable Audio

@ Switch to Live View

"= Full Screen

The following buttons are available on the right-click Instant Playback Management Menu:

« Reverse Playback

» Pause/Play

= Stop
Fast Forward/Slow
e
Forward
1™ |4 Single Frame (Reverse)
& Open Digital Zoom
E Capture
E=H Other Capture Modes

© @ start/stop Recording
&2 &) Enable/Disable Audio
@ Switch to Live View
= Full Screen

Play back the video file reversely.
Pause/Start the instant playback in the display window.

Stop the instant playback and return to the live view mode.
Increase/Decrease the play speed of the instant playback.

Play back the video file frame by frame (reversely).

Enable the digital zoom function. Click again to disable the
function.

Capture the picture in the instant playback process.

Print Captured Picture: Capture a picture and print it.

Send Email: Capture the current picture and then send an Email
notification to one or more receivers. The captured picture can be
attached.

Custom Capture: Capture the current picture. You can edit its
name and then save it.

Start/Stop clipping the video files.

Click to turn on/off the audio in instant playback.

Switch to live view mode.

Display the instant playback in full screen mode. Click again to exit.

4.6 Custom Window Division

Purpose:

The client software provides multiple kinds of pre-defined window division. You can also set custom

window division as desired.

Steps:

1. Click B on the live view toolbar and select Edit to pop up the custom window division dialog

box.
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2.

3.

4.
5.

Edit Custom Window Division x

4 Add Delete

Name: 3x3 Joint

Click Add to open the custom window division adding dialog box.

Note: Up to 5 custom window divisions can be added.

Set a name for the new window division as desired and click OK to save the settings.

Add Custom Window Division

[windomd

You can edit the name, window division (3x3, 4x4, 5x5) for it.

Click-and-drag you mouse to select the adjacent windows, and click Joint to joint them as a

whole window. You can also click Cancel to cancel the jointing.

Edit Custom Window Division x

+ Add ¥ Delete

Name: window dx4 ~ [ Joint

Save

Click Save to confirm the settings. Click Ed to back to the Main View page. Then you can click

[E: and select the custom window division for playing live video.
Notes:

Cancel

[H Cancel

® You can also enter the Remote Playback page and perform the steps above to configure the

custom window division.

® For remote playback, up to 16 windows can be played back at the same time. The custom
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window division with more than 16 windows is invalid for playback.

4.7 Live View in Fisheye Mode

Purpose:

The live video of the camera can be played in fisheye expansion mode.

Steps:

1. Start the live view (refer to Chapter 4.1 Starting and Stopping the Live View).

2. Right-click on the video and select Fisheye Expansion to enter the Fisheye Expansion window.

3. Select the mounting type of the fisheye camera according to the actual mounting position.

4. You can select the expand mode for live view as desired.
Note: For some devices, you can select the mounting type of the device and the related expand
mode will be listed.

Mounting Type Cameral_Fisheye

Expand Mode

| =l =9

®  Fisheye: In the Fisheye view mode, the whole wide-angle view of the camera is displayed.

This view mode is called Fisheye because it approximates the vision of a fish’s convex eye.
The lens produces curvilinear images of a large area, while distorting the perspective and
angles of objects in the image.
® Panorama/Dual-180° Panorama/360° Panorama: In the Panorama view mode, the
distorted fisheye image is transformed to normal perspective image by some calibration
methods.
® PTZ: The PTZ view is the close-up view of some defined area in the Fisheye view or
Panorama view, and it supports the electronic PTZ function, which is also called e-PTZ.
Note: Each PTZ view is marked on the Fisheye view and Panorama view with a specific
navigation box. You can drag the navigation box on the Fisheye view or Panorama view to
adjust the PTZ view, or drag the PTZ view to adjust the view to the desired angle.
5.  You can right click on the window and select Capture to capture the picture in the live view
process. The capture picture is stored in the PC.
6. Right-click on a playing window and you can switch the selected window to full-screen mode
Press ESC key on the keyboard or right-click on the window and select Quit Full Screen to exit the

full-screen mode.
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PTZ Control
In PTZ mode, you can use the PTZ control to adjust the PTZ window.
Note: The PTZ panel varies according to different devices.
® Select a PTZ window, and click one of the direction buttons to adjust the view angle.
Note: Click-and-drag the No. label in the fisheye or panorama window will change the view angle

of the PTZ window as well.

Select a PTZ window, and click ©' to start auto-scan, and click it again to stop auto-scan.

= = +: Drag the slider to adjust the speed for PTZ movement.

° * @ " . Zoomin or zoom out the selected PTZ window by clicking [*/ or [=. Oryou can

scroll the mouse wheel to zoom in or zoom out.
Preset
Note: The preset is only supported by specific fisheye camera.
A preset is a user-defined monitor position/point. You can simply call the preset No. to change the
monitor scene to the defined position. Please follow the steps below to configure the preset.
Steps:
1. Click Preset tab to enter the preset configuration interface.

2. Select a PTZ window, and adjust the scene to the place you want to mark as a preset.

3. Click @, input the preset name, and click OK to save a preset.

Add Preset

4. (Optional) Click i to call the configured preset.

5. (Optional) Click B to delete the configured preset.

Patrol

Note: The preset is only supported by specific fisheye camera.

A patrol is a scanning track specified by a group of user-defined presets, with the scanning speed
between two presets and the dwell time at the preset separately programmable. Please follow the
steps below to configure the patrol.

Note:

At least 2 presets have to be configured before you configure the patrol.

Steps:

1. Click patrol tab to enter the patrol configuration interface.

2. Select a path No. from the drop-down list.

3. Click ™" to add the configured presets, and set the dwell time and patrol speed for the preset.
4

Repeat the above operation to add other presets to the patrol.
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6. Optionally, you can click # or B to edit or delete a preset in the patrol path.

5. Click
Notes:

[

[

[

[

4.8

Purpose:

The fisheye camera and box/bullet camera support master-slave linkage function so as to locate or

Add Patrol No x

Preset: Presetl ~

Dwell Time(s). | s

Patrol Speed: 30 .

I3 to start the patrol, and click & to stop patrol.

Up to 256 presets can be configured.
Up to 32 patrols can be set.
The dwell time ranges from 1 to 120s.

The patrol speed ranges from 1 to 40.

Starting Master-slave Linkage

tracking the target according to your demand.

Notes:

®  This function in only supported by the specific fisheye or box/bullet camera.

® A speed dome with the auto-tracking function is required to be installed near the camera.

Master-slave Linkage for Fisheye Camera

Steps:

1. Right click on the panorama view of fisheye camera and select Remote Configuration to enter the

Remote Configuration interface.

2. Click Fisheye menu to enter the following interface.
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3.
4,

10.

11.

@ Remote Configuration

4 & system
& Device Infor.
% General
& Time
&g System Mai.
@ RS232
& RS485
& Log
@ User
@ Serice
'»‘g Fisheye
& Network
> & Storage
4 @ Event

@ Alarm

& Email

& Exception
& Schedule
& Line Crossi.

% Motion Dete._..
& Tampering ...
& Video Signal...

% Intrusion De...

Configure Fisheye Parameters.

Mounting Type: [Celling

v

Stream Mode:

[Mode 3: Fisheye (Main Stream) + Fisheye (Sub Stream) +3... '] [Tracking Paramet... ]

Speed Dome Calibration:

Camera Details:

X 0

Y: 0

P359i100 Z001

-

Dome:

8597
Titt 357

Pan

@ cco
> & Image
& HeatMap

Zoom: 24

Horizon Line ] [ Calibration 1 ][ Calibration 2 ] [ Clear ][ Link ]

Apply

Select the mounting type of the speed dome, and select the stream mode for the fisheye camera.

Click Login to add the speed dome.

il Login =

Device IP Address:

10.96.15.125 |

Port: 8000

Name: admin

HRAEE

Password:

Input the device IP address, port No., user name, password, and click Login.

Click PTZ Control, and use the direction arrows to adjust the speed dome to a horizontal position.

Note: If the speed dome is adjusted to the horizontal position, the tilt degree is close to 0.

Click Horizon Line to set a horizon line, and a message of “Setting horizontal line succeeded” pops

up if the line is set.

Move the No.1 calibration cross to the middle area of the fisheye camera, and you will see a small

picture under the fisheye camera. Use the PTZ to adjust the speed dome to the same position,

and click Calibration 1 to finish a calibration setting.

Move the No.2 calibration cross to the second position, and use the PTZ to adjust the speed dome

to the same position, and click Calibration 2 to finish the second calibration setting.

Note: You can click Clear to delete the configured calibrations.

Click Link to link the speed dome to the fisheye camera.

Click Tracking Parameters to select the tracking method.

Notes:

® The speed dome linkage works as the linkage method of the intrusion detection and line
crossing detection if any of those alarms is triggered.

® Right click on the live view window of fisheye camera, and go to Remote
Config >Event >Intrusion/Line Crossing to check the checkbox Smart Tracking to enable the
tracking function.

Click Save to save the settings
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12. (Optional) You can also right click on the panorama view and select Start Master-slave Linkage.

Master-slave Linkage for Box/Bullet Camera

Then you can make the speed dome to track target manually by clicking the target on the live

view of fisheye camera.

Note: If you want to see the speed dome linkage, you should add the speed dome to the software

(Section 3.1 Adding the Device) and start live view (Section 4.1 Starting and Stopping the Live View)

of it.

Steps:

1.
2.

Enter Remote Configuration -> VCA Config -> Rule -> Rule Settings.

Select Camera No.1, and click * of Rule List to add rule.

Select Intrusion as Event Type, and then click © ' to draw the zone of intrusion rule and click

Save to save the settings.

+ & system

RuleList 4 Add

+ @& Network

Max. Single Rule Number: 8

+ @ Storage |
+ 4@ Event

Rule No.

v

Rule Name

Inrusion Detection|

Event Type

Infrusion v R

A3

+ @ Aadvance Configuration
+ @ cco
+ @ image

Size Filter

‘Combined Rule

~ & VCAConfig
1
) vCAInformation
%) Capture and Display
"% Scene and Calibration

Shield Reglon

Color Filter
Arming Schedule
Linkage Action

= 48 Acvanced Configuration
Parameters

Global Size Fiiter

Instruction

I Enable Wizard

P

+ Add

ode

Duration (s): 0

Natartinn Tarnat an

Max Combined Rule Number: 2

0

Restat VCA save

Login the speed dome.

1) Inthe Remote Configuration interface, select Advanced Configuration->Master-Slave

Tracking to show the login interface.

2) Click Login button to pop up the speed dome login dialog box.

3) Input the required information.
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5.
6.

Click PTZ, and use the direction arrows to adjust the speed dome to a horizontal position.

= @ system

& Device Information

@& General

& Time

& System Maintenance

& Rs232
& Rs485
& Log
@ User
& Security

+ @ Network

+ @ Storage

+ @ Event

= @ Advance Configuration

-]
+ @ cco
+ @ Image
+ & VCAConfig

Configuring the Master-slave Tracking Parameters

Device IP Address: 10.16.1.250

Port 8000

UserName: admin
alibration Tracking
fauto Calibrating v

fSlave Camera 1

onnection Status: Online SetRatio Save

Calibration succeeded.

Click to select the calibration tab page.

Calibration Tracking
|Auto Calibrating v

Sel Ratio Save

Select Auto Calibrating from the calibration list.

Perform the calibration operation.

Move and zoom in/out the speed dome to make sure the live views of dome and camera is

For Auto Calibrating:
1)
2)

mostly the same.
3)

For Manual Calibrating:

1)

2) Select No. 1 from the list and click +, a blue cross appears in the center of the live view

3)

4)

Click Save to save the calibration settings.

Select Manual Calibrating from the calibration list.

page, and the digital zoom view of the selected site appears on the right.

Select No. 2 to No. 4, and repeat the step above to add the manual calibration sites.

Calibration Tracking

Manual Calibrating 2
...| Position PTZ Position ~_
2 (0.576,0.618) (332,0,0.9)

3 (0.633,0618) (327.4,0,0.9)

4 (0520711) (3351009)

o e

Set Ratio Save

Perform the calibration operation.

Adjust the distances between the four calibration sites evenly in the live view page.
Select calibration site No. 1 and the digital zoom view of site No. 1 appears on the right.
Move and zoom in/out the speed dome to make sure the live views of dome and the digital
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zoom view of selected site is mostly the same.
Click il to save the current site position information.
Select No. 2 to No. 4, and repeat the steps above to save the site position information.
Click Save to save the calibration settings.
7. Right-click on the live view window of camera to show the menu and click Enable Master-slave
Tracking.
8. When configured VCA rule is triggered by target, the speed dome performs the automatic

master-slave tracking and the target frame turns from green into red.

4.9 Other Functions in Live View

There are some other functions supported in the live view, including digital zoom, two-way audio,

camera status and synchronization.

Auxiliary Screen Preview

The live video can be displayed on different auxiliary screens for the convenient preview of multiple

monitoring scenes. Up to 3 auxiliary screens are supported.

Digital Zoom

Use the left key of mouse to drag a rectangle area in the lower-right/upper-left direction, and then the
rectangle area will zoom in/out. You can also use the mouse wheel for zooming in or restoring of the

video in digital zoom mode.

Channel-zero

For the channel-zero of the device, you can hold the Ctrl key and double-click to display the specific

channel. Hold the Ctrl key and double-click again to restore.

Two-way Audio

Two-way audio function enables the voice talk of the camera. You can get not only the live video but
also the real-time audio from the camera. If the device has multiple two-way audio channels, you can
select the channel to start two-way audio.

The two-way audio can be used for only one camera at one time.

Camera Status

The camera status, such as recording status, signal status, connection number, etc., can be detected

and displayed for check. The status informati